
Walkup NMR Quick Guide 
 
Use this page to quickly reference the order of operations on the walkup NMR instruments.  
For more information on any of the steps, see the detailed walkthrough or contact the MRC staff. 

 
 
1. Schedule time on the MRC scheduling calendar. 

 
2. Login to the instrument using your NMR username and password. 
 
3. Eject the standard and insert your sample. 
 
4. Enter a sample name (optional) and select the solvent (required). 
 
5. Lock the sample using Auto Lock or by manually locking. 
 
6. Shim the sample (maximize the lock level using the shims). Shim order: Z1, Z2, Z1 
 
7. Verify the lock power is less than the lock gain and set the lock level between 30 and 70. 
 
8. Select the desired experiment from the Experiment Selector. 
 
9. Adjust parameters under the Acquisition tab. Make sure Auto Gain is checked. 
 
10. Start the experiment with ga or click the  Go  button. 
 

11. Process the data. You will need to at least transform the data (wft) before saving/emailing. 

i. Most processing can be completed using the  Auto process  button on the Process tab. 
 
12. (Optional) Plot your spectrum. 
 
13. Save and/or email your data. 
 
14. Continue with your next experiment. (Step 7)  

OR 

Change to your next sample. (Step 2) 
 
15. If finished, check the height of the standard D2O sample and insert it into the magnet. 

 
16. Logout and complete the logbook with any missing information.  



Walkup NMR Walkthrough 
Notes on sample prep: 

All sample preparation is to take place in your wet lab. No preparation equipment is permitted in 

the NMR labs without prior permission from the MRC staff. If you need to bring anything other 

than NMR tubes to the lab, consult the MRC staff before scheduling time. Gloves and lab coats are 

not permitted in the NMR labs. Remove any gloves at the door before using the instruments. 

Samples should be free of particulates (filtered) and non-viscous for best lineshapes. Make sure 

your sample height is 5 cm tall (about 0.6-0.7 mL solvent) and is sealed only with a plastic cap. 

Do not use parafilm, foil, or PTFE tape (alone or wrapped around a plastic cap) to cap your 

samples.  

1.  Place any ferromagnetic items on the desk (watch, 

keys, bracelets, etc). This includes metal objects 

such as buckles if freely hanging from your clothing. 

 

Sign into VnmrJ near the bottom of the screen with 

your NMR username and password. 

 

2.  Load your sample into a spinner and use the depth 

gauge to set the sample height. You will need to 

raise the tube in the spinner for shorter samples 

(B). Samples 5 cm in height or greater should be 

inserted fully into the sample depth gauge (A).      

Do not place the spinner into the depth gauge 

before loading your sample. This risks breaking 

your NMR tube. Load samples into spinners by hand 

first; making sure your hand is not more than 10 cm 

from the top of the spinner to avoid snapping your 

tube. Avoid touching the sample area of the tube to 

prevent finger oils from showing in the spectra.  

 

 



3.  Select the Start tab if not already selected.    Click 

the  Eject  button or enter e on the command line. 

Take out the sample in the magnet and place it in 

the sample rack. 
 

4.  Insert your sample into the magnet bore. Make sure 

the sample will float at top before releasing it. 

Click the  Insert  button or enter i on the command 

line. 
 

5.  Enter a sample name (A, optional) and select the 

solvent (B, required) on the Sample Info page. Use 

the drop-down menu to select a solvent other than 

DMSO, CDCl3, or D2O. 

It is recommended to enter basic information about 

the sample in the Comments box (C), which will 

help you keep data organized. 
 

6.  Click the  Auto Lock  button. After the process 

runs, wait for the lock level to stabilize and regulate. 

If Auto Lock fails, a message will appear in the top 

command window and you will need to lock 

manually (Step 7). Otherwise skip to Step 8.  

7.  Manual locking 

• Select the Lock page 

• Uncheck the Lock checkbox to turn off lock.  

!    Lock must be off before adjusting Z0. 

• Click  Lock scan .  

• Adjust Z0 to obtain zero beat frequency (E, on-

resonance, ‘stairstep’ shape line). If starting far 

from the on-resonance value, you occasionally will 

see a sine wave with multiple periods (A). To get 

lock, move Z0 such that you decrease the number 

of periods seen (B→D) until you reach E. The 

value can be increased by right-clicking on the Z0 

button or decreased by left-clicking. The middle 

click will adjust the step size between 1, 10, and 

 

 

 



100. Specific values may be typed into the text box 

next to the button. You must press Enter after 

typing the number to activate it. 

• If necessary, adjust Gain to keep the lock level in 

the middle of the screen while adjusting Z0. The 

Gain slider should always remain above the 

Power slider. Do not continue adjusting Z0 if the 

line reaches the top of the screen (Lock Level > 

80). Reduce the Power and/or Gain first, and then 

continue. If Gain reaches the maximum, you can 

increase Power, but it should not be increased 

past 40 except for low sample sizes or low 

deuterium-concentrated solvents. Do not adjust 

the Phase parameter yet. 

• Click the  Lock checkbox to turn on and regulate 

lock. 

 

 
 

 

8.  Shimming 

• Select the Shim page and adjust the Lk Power and 

Lk Gain if necessary so the lock level is around 30-

50. 

• On the 300: Adjust Z1C to maximize the lock level 

and then adjust Z2C (both highlighted in yellow). 

Any time you adjust Z2C you should then readjust 

Z1C. Repeat adjustments until a maximum is 

reached. 

• On the 300 and 400: Adjust Z1 and Z2 (highlighted 

in green) in the same manner as above to make 

fine adjustments to the lock level. 

• If at any time the Lock level maxes out (≥100), 

reduce Lk Power and Lk Gain together to lower the 

Lock value < 80 and continue. 

• Adjust Lk Phase to maximize the lock level.  

• Adjust Lk Power and Lk Gain to set the Lock Level 

between 30 and 70. Verify that the Gain slider on 

the Lock page is above the Power slider and adjust 

as needed. 

 
 

 

 

 



9.  Running an Experiment 

• Select the Acquire tab 

• Select an experiment from the left-hand side 

(e.g. PROTON, CARBON, etc). If the buttons are 

missing, look under the Protocols tab or select 

Experiment Selector from the View menu. 

 

10.  The Default [Nuclei] page contains the most 

frequently adjusted parameters and common 

values for each. All these values should be verified 

before running. If a desired value is not present in 

the drop down, custom values may be entered in 

the corresponding field on the Acquisition page. 

 

Verify that the  Autogain checkbox is  

selected on the Default page. 

 

 

General Notes: 

• The default instrument parameters are set to obtain survey spectra with the optimum 

signal-to-noise in the shortest time for average MW. They usually work for proton 

counting (i.e. distinction between CH, CH2 and CH3 proton resonances), but are NOT 

suitable for quantitative analysis. The user can modify the parameters to get desired 

results according to their project needs. 

• For accurate quantitative analysis, parameters must be altered (e.g. for quantitative 1H 

spectra pw(90) and d1=5xT1; for quantitative 13C spectra pw(90), d1=5xT1  and dm=’nny’). 

You can guess T1 based on prior knowledge from your group’s work or published results 

with similar samples. However, you should perform a T1 measurement experiment and 

use identical sample preparation conditions (solvent, analyte, concentration, temperature) 

if you wish to use that measured T1 as a basis for quantitative analysis of future samples. 

You should consult the MRC staff to ensure proper experimental setup before running 

quantitative experiments if you plan to publish the results. 

• If you work with atypical structures (e.g. paramagnetic materials, anions or cations) the 

default spectral window might not be suitable.  

• Data processing can dramatically influence the reliability of quantitative analysis. For best 

results, contact the lab staff for instructions on quantitative data processing.  



• Signal-to-noise can be improved with larger number of scans (Scans requested, nt). 

Always use nt equal to a multiple of 4 to avoid artifacts in the spectra. 

• The  Show time  button will display the length of the experiment in the command window. 

• Line broadening (lb) and transform size (fn) can be set before acquiring data, but can 

also be set while processing (which is why you’ll find them under the Processing tab). It is 

recommended to set the transform size to 2X the number of points to improve lineshape. 

You can quickly do this by entering fn=2*np on the command line. Recommended values 

of lb are 0.5 or 1 for 1H and 1 or 2  for 13C to improve the signal-to-noise. 

11.  Start the experiment by clicking the  Go  button or 

entering ga on the command line. Use 

the  Stop  button or enter aa on the command 

line if you need to end the experiment for any 

reason. 

 

Leaving the instrument unattended 

You may leave an experiment running without placing an ‘experiment in progress’ sign at the 

instrument. Fill out the logbook and include your phone number and solvent(s) before leaving.  

The screen will lock after 10 minutes or you can click the  Lockscreen  button in the Start tab. 

 
 

 
Data Processing 

 
Your data should automatically process at the end of the experiment. Steps 12-17 will walk 
through basic data processing in VnmrJ. You may skip to Step 19 if you prefer to just save your 
data and process it later. 
 

12.  Select the Process tab and click 

the  Auto process  button. This will transform the 

data, reference to TMS or the solvent, auto-phase 

the spectrum, and adjust the vertical scale. If you 

are happy with the results, you can skip to Step 

18 to print your data. 

Note: This process runs automatically if you start the 

experiment with the  Go  button. Starting an 

experiment with ga will only transform (wft) the 

spectrum at the end of the experiment. 

 



13.  Basic Processing Tools 

A.  Toggle between 1 or 2 cursors on the screen. 

Also restores display mode. 

B.  Show full spectrum 

C.  Expand region (white space) to full window 

D.  Zoom in to the area between cursors. Set 

cursors by left-clicking on the left side of the 

region and right-clicking on the right side. 

Then click this button to zoom in. 

E.  Zoom out 

F.  Click this button and then click-and-drag the 

region you want to expand/zoom in. 

G.  When zoomed-in, this tool can be use to 

move/scroll the spectrum left or right. It can 

also be used to adjust the vertical position of 

the spectrum. 

H.  (top) Display the time domain or FID. 

Command: df 

I.  (top) Display frequency domain or spectrum. 

Command: ds 

• You can use the mouse scroll wheel (or click-

and-drag with it) to adjust the vertical scale 

(height) of the peaks. 

• The Weighting page under the Process tab 

contains the tools to change the line 

broadening (lb), transform size (fn), and run 

autophase (aph0). 

 

 

 

 

 

 

 

 

 

 

 

 

 



14.  Phasing 

To manually adjust the phase, click the phase 

mode button in the right tool menu. Then single-

click a peak near the baseline on either the far 

right or far left. Click and drag vertically within the 

two red lines that appear to adjust the phase of the 

peaks within the region. Left click-and-drag will 

course-adjust the phasing and right click-and-drag 

will adjust more finely. If needed, click on a peak at 

the opposite end of the spectrum and repeat on 

that region to phase. Note that this second phasing 

step will have a larger affect on the whole 

spectrum and you might want to use the right 

mouse button to adjust. To exit phase mode, click 

the top button in the right tool menu (Step 13 A) 

or scroll within the spectrum window. 

 

 

 

15.  Referencing 

• Zoom in on the reference peak and left-click near 

the center of the peak. Click the nearest line 

button in the right tool menu or enter nl on the 

command line. 

o Enter rl(#.##p) on the command line 

where #.## is the desired chemical shift. 

• The same tools can be found on the Display page 

in the Process tab. Click on the peak, click 

the  Nearest line  button, and then enter the 

reference value in the text box and press enter or 

click the  By cursor  button. 

The  By solvent  and  By TMS  buttons will auto-

reference to the solvent peak or TMS peak 

respectively. 

 
 

 

16.  Peak Picking (Labeling) 

• Click the display peak frequencies button in the 

right tool menu (B). Doing this first will allow the 

peak labels to dynamically update in the next 

step.  
 



• Click the set threshold button (A). Vertically drag 

the orange horizontal line in the spectral window 

to adjust which peaks are labeled. To exit the set 

threshold mode, click button A again. 

 

17.  Integration 

Integration in VnmrJ is a little different than other 

software packages. The toolbar changes for the 

integration buttons. When integral lines are turned off 

(normal mode), you will just see one button as in 

column A. Clicking a button in row 1 will cycle 

between columns A through C. 

 

Turn off integral lines 

The peak vertical scale can’t be adjusted while 

displaying the integral lines. To turn these off, click 

the yellow C1 or type intoff in the command line. 

Delete all integral regions 

To reset/erase all integral regions, click C2 or enter 

cz in the command line. 

Set integral regions 

• Click B2 (orange scissors). 

• Left-click to set an integral region point. It is best 

to click the left side of the peak and then click the 

right side of the peak to set the region. Defined 

regions (completed integrals) will show as a solid 

green line. The ‘blank space’ between integrals 

will show as a dotted line. 

o You can ‘undo’ or delete an integral region point 

by right-clicking near that location. This can be 

useful to expand/contract regions. You can 

delete the start or stop point of the region and 

then left-click at the new position. 

o To exit the set integral mode, click the display 

cursor button at the top of the tool menu (Step 

13 A) or enter ds or wft in the command line 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 



• Integral values can be displayed by clicking 

the  Show integral values  button on the 

Integration page under the Process tab. By 

default, this will display values whose sum is 100. 

• To define the area of a peak, place the left red 

cursor on the peak, click the ⦿ Single peak radio 

button, and enter a value in the Integral area text 

box on the Integration page and click 

the  Set integral value  button. Then redisplay the 

integrals. 

o Use the ⦿ Sum setting above to redefine the 

total integral from the default of 100. 

• For accurate integrals, make sure the spectrum is 

properly phased and try to define the regions 

from baseline to baseline.  

 

 

 

18.  Print Spectrum 

All basic print options can be found on the Plot 

page under the Process tab. Toggle the options 

you want and click  Print . The  Preview  button 

can be used to preview the selected options or to 

save a PDF of the spectrum instead of printing.  
 

19.  Saving and/or emailing data 

Save 

• Data is not automatically saved on the walkup 

instruments! You must save/email the data 

after each experiment or the data will be lost.  

• Click the Save As floppy icon or File>Save As… 

o Navigate to the desired directory, enter a file 

name, and click Save in the popup window. 

• It is recommended to verify the file has saved 

by clicking Save As again and checking the file 

is listed in the directory. 

 

 

Email (send data as a .zip file) 

• Click the Gmail icon or File>Email the FID 

 
 

 



• If a sample name and/or email was not 

provided before running the experiment, you 

will be prompted on the command line. 

o The email address must be either an 

@zips.uakron.edu or @uakron.edu address. 

 

 

20.  Continue Experiments or Samples 

• Goto Step 9 to continue running experiments on the same sample 

  OR 

• Goto Step 2 to continue with your next sample 

21.  Finish 

• Click the Start tab 

• Check the sample height of the standard (D2O) 

sample using the depth gauge. 

• Replace your sample with the standard. 

• Click  Logout  in the Start tab or enter done  

on the command line 

• Complete the logbook with your logout time 

and any missing information. 

 

ALWAYS VERIFY THAT YOU HAVE LOGGED OUT BEFORE LEAVING! 

You will be charged based on the amount of time you are logged onto the instrument.  
To avoid excess fees, make sure you see the login screen in Step 1 before you leave. 

 


